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Executive Summary 
The overreaching aim of this document is to provide users of the SO WHAT Advanced Tool detailed 

instructions on how to install, navigate, and utilise the various pieces of software, as well as 

identifying relevant technologies, buildings, and data to be used within the analysis, for the purposes 

of waste heat/cooling recovery and reuse. 

The document is intended to be used as a step-by-step guideline to enable new users to get started 

with creating pilot site models, as well as with investigating ways to recover and exploit their waste 

heat and/or cold (WH/C) resource potential, either by re-using this resource internally (on-site) or by 

distributing it externally (to local district buildings/sites through a district heating/cooling network). 

Also included is a methodology on how individual sites may identify relevant waste energy recovery 

technologies to investigate and model as well as the relevant building and data that would be best 

suited to this analysis.  

It should also be noted that as well as a formal deliverable, this report will be updated and used as the 

paper version of the manual for people to use and it will also form the basis for the online version 

(D4.6 Delivery of self-learning modules). Alongside this, training videos will be produced, as part of 

D7.6 Training Resources for Relevant Stakeholders. 
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Introduction 
This document represents the Deliverable 4.8 which contains a manual for the SO WHAT 

commercial/advanced tool. It is intended to be used as a step-by-step guideline to enable new users 

to get started with creating pilot site models, as well as with investigating ways to recover and exploit 

their waste heat and/or cold (WH/C) resource potential, either by re-using this resource internally (on-

site) or by distributing it externally (to local district buildings/sites through a district heating/cooling 

network). 

This manual will highlight the relevant IES and RINA-C software to download for this project, how to 

download it, and how to utilise the tools to develop a model appropriate for waste heat/cooling 

energy recovery.  This includes how to prepare the models, upload data, run simulations, and review 

and analyses the results.  

A methodology on how individual sites may identify relevant waste energy recovery technologies to 

investigate and model as well as the relevant building and data that would be best suited to this 

analysis has also been included. 

As such, the document has not been written in a standard SO WHAT deliverable format, and differs 

in the numbering of its different sections. This is to enable the easy production of the SO WHAT 

Manual to be lifted directly from this document both on paper and online (D4.6 Delivery of self-

learning modules). 

This document is structured into 3 main Sections.  

• Section A details the installation process of the relevant IES software.  

• Section B outlines the setting up of models, collecting of relevant data, and initial energy 

simulations for both baseline and comparative theoretical model.  

• Section C discusses how to identify relevant buildings and technologies and mentions the 

integration of RINA-C’s PLANHEAT for analysis of the SO WHAT tool for community models. 
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Section A Install the SO WHAT software 
Below is a sequence of steps to be followed for installing each of the software for SO WHAT purposes. 

Prior to these steps, the user should have sent an e-mail to info@SO WHATproject.eu asking for the 

software licences. The user should then have received an e-mail with instructions to follow. This 

should occur prior to the next steps. 

Please make sure you follow every single step as written in the sequence, as missing one will cause 

some installation problems. 

To begin the process of activation of all the licences, please create an account with www.iesve.com.  

• Click on login and then – click on here to register. https://www.iesve.com/register 

• Enter all required details and create an account. (use the same email address as that to 
which this email is sent to create the account) 

1. Install IES VE 
To activate your keys through our new license management system, you will need to be on a machine 

that has VE (download here) and pointing to the current keys folder location. Then follow the below 

steps: 

• In VE, select Help → Troubleshooting → Set License Folder  
• The file path will be displayed. Navigate to that folder and please delete the keys.txt file 

therein.  
• Once deleted, go back to VE 2019, and select Help → Request License  
• Complete the form with the Activation Code: 
• Select ‘Activate’  
• Click ‘Send Request’ and license will be updated within the hour  

Once a code has been used it cannot be used again. 

If you get an error upon completing the above, please follow these instructions: 

• Open VE → Help → request license key 

• In tab Action, select “Request free trial” do not send the request 

• In the same tab action, select “Activate/Refresh software again 

• Send request 

Once you have successfully installed VE, please then follow the iCD steps below. 

1.1 Additional free training for IES VE 
If you would like more training in this, it is suggested that the user watches the free Getting Started 
with the VE on-demand series here https://distance-learning.iesve.com/p/getting-started. You will 
need to enrol and/or login to IES Distance learning to access. 
 
You might also find the series of free on-demand ICL (Intelligent Community Lifecycle) Digital Twin 

courses from the Upskill with IES series useful https://learn-on-

demand.iesve.com/courses/category/icl-digital-twin and there are also live online training options 

with an instructor available here https://www.iesve.com/training/online-training. 

mailto:info@sowhatproject.eu
https://bits.zynbit.com/link?guid=cc3cd114-2c82-4494-845a-9f927e4dbf7e&url=https://urldefense.proofpoint.com/v2/url?u=http-3A__www.iesve.com&d=DwMGaQ&c=KWFQGcMK0IJkSyjAXKqofg&r=1d9myzETY62Mvt5L-KLk5W5HCYO2DEk9fMH8ZEMr_Oc&m=hREcvvq9AYHLdO9PvVKIxFYqvpqzCYdLlDEaZWIeUGo&s=RueGmEyDuvfO_gnjlYBP_Tm3-ZG6YJTnVpuze1aMgz4&e=
https://bits.zynbit.com/link?guid=9ce02f88-2bab-450d-bddb-e27bba9f750c&url=https://urldefense.proofpoint.com/v2/url?u=https-3A__www.iesve.com_register&d=DwQFAg&c=KWFQGcMK0IJkSyjAXKqofg&r=nPUbFrpE9ll3KY8826Mz3w5nYNlyZ-afWWnKr838dXw&m=EOV0COmQpOMhNKJO20djFvtOUMMJ2vLBtPZDkvVBi9M&s=bnn_Ow2Zg72vWeNAnZ1mkuSV7y7EvaMjsZxa7AkZrPs&e=
https://bits.zynbit.com/link?guid=15b94efa-074a-4608-8534-a6604f7b5cbf&url=https://urldefense.proofpoint.com/v2/url?u=https-3A__bits.zynbit.com_link-3Fguid-3D2e5c5eff-2D2d1a-2D48c1-2D88d1-2D02d7dba50215-26url-3Dhttp-3A__www.iesve.com_software_download_ve-2Dfor-2Dengineers-3Fid-3D451&d=DwMFAg&c=KWFQGcMK0IJkSyjAXKqofg&r=nPUbFrpE9ll3KY8826Mz3w5nYNlyZ-afWWnKr838dXw&m=EOV0COmQpOMhNKJO20djFvtOUMMJ2vLBtPZDkvVBi9M&s=0SDcdPrsR9l27JjdAVNZD90e9PIhwxDq3dW3Qb_UzWY&e=
https://distance-learning.iesve.com/p/getting-started
https://learn-on-demand.iesve.com/courses/category/icl-digital-twin
https://learn-on-demand.iesve.com/courses/category/icl-digital-twin
https://www.iesve.com/training/online-training
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2. Install IES iCD 
• Download Sketch Up – 2018 version and above (and below 2022 version for and iCD 2021 

version and below). (iCD is a Sketchup plugin) 

• Log into https://www.iesve.com/login – please use the same login and password as created 
above.  

• Download latest installer from website - https://www.iesve.com/support/icd/download  

• Once you download and install the plugin, then go to Extension s→ IES iCD → 
Troubleshooting and License → Request License Keys 

• Enter all details below, then enter activation code. 

• Activation Code – same as the VE code: 

• Send request 

• A few videos to get you going: https://www.iesve.com/products/icd/trial and 
https://youtu.be/PQsOGhz6EnU  

• Free Training can be found here https://distance-learning.iesve.com/p/getting-started-with-
icd. You will need to enrol and/or login to IES Distance learning to access. 

• There is also an online User Guide available in the help section of the tool (last icon in iCD 
toolbar) and an online support section containing lots of getting started resources here 
https://www.iesve.com/support/icd  

 

If there is an issue with activation email keys@iesve.com and someone from the IES support team 

will be able to assist. An automatic email with the following message will be sent and someone will 

return with assistance in time. 

“For iSCAN, iVN & iCIM the keys team has not yet given you access to use the software, but they will do 

so in the next 24 hours. So please follow these steps tomorrow.” 

2.1 Additional details regarding SketchUp installation 
SketchUp can be downloaded from the SketchUp website (https://www.sketchup.com/plans-and-

pricing#for-professional). However, please note it requires subscribing for a plan to purchase your 

own licence. SketchUp Pro is the version is recommended because a desktop version is required to 

enable an installation and use of the IES iCD Plugin, whereas additional functionalities offered by 

SketchUp Studio version is not necessary. For example, at IES we avail of a company plan for 

SketchUp Pro. 

The only way to use SketchUp for free is to first apply for a 30-day free trial, so if this is the option you 

would like to proceed with, you should wait before installing the IES iCD Plugin until when it is 

necessary to work on software. 

3. Install IES iVN 
• Download the latest installer from website - https://www.iesve.com/support/ivn/download 

• You will need to log in to the website using the same login and password as created above.  

• Use your same iesve.com login to sign in to the iVN and start using it.  

• A few videos to get you going: https://www.iesve.com/products/ivn/trial and 
https://www.youtube.com/watch?v=74bH2OBQCr8&feature=youtu.be 

• Free Training can be found here https://distance-learning.iesve.com/p/getting-started-with-
ivn. You will need to enrol and/or login to IES Distance learning to access. 

https://www.iesve.com/login
https://bits.zynbit.com/link?guid=8f7b4a67-81a0-488b-b705-c0ae9cd57847&url=https://urldefense.proofpoint.com/v2/url?u=https-3A__www.iesve.com_support_icd_download&d=DwMFAg&c=KWFQGcMK0IJkSyjAXKqofg&r=nPUbFrpE9ll3KY8826Mz3w5nYNlyZ-afWWnKr838dXw&m=EOV0COmQpOMhNKJO20djFvtOUMMJ2vLBtPZDkvVBi9M&s=xSRaiebWaxskOk0YgCKVczJch3nZZ3cRB-J0HAl-qDg&e=
https://www.iesve.com/products/icd/trial
https://youtu.be/PQsOGhz6EnU
https://distance-learning.iesve.com/p/getting-started-with-icd
https://distance-learning.iesve.com/p/getting-started-with-icd
https://www.iesve.com/support/icd
mailto:keys@iesve.com
https://www.sketchup.com/plans-and-pricing#for-professional
https://www.sketchup.com/plans-and-pricing#for-professional
https://www.iesve.com/support/ivn/download
https://www.iesve.com/products/ivn/trial
https://www.youtube.com/watch?v=74bH2OBQCr8&feature=youtu.be
https://distance-learning.iesve.com/p/getting-started-with-ivn
https://distance-learning.iesve.com/p/getting-started-with-ivn
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• There is also an online User Guide available on the ‘start’ page in iVN (accessed by clicking 
the first icon in iVN toolbar) and an online support section containing lots of getting started 
resources here https://www.iesve.com/support/ivn 

 
Regarding the installation of multiple iVN builds, when necessary, please create a shortcut on your 

desktop to where IVN is installed e.g., C:\Program Files\IES. When you install an iVN build, then please 

rename the build accordingly (see screenshot below). As you can see, a user can have at least 10 

versions of iVN on their laptop, e.g., iVN 2021_3_0 - 192897 (FB1 - 10122021), i.e., iVN [Version] - 

[change list number] (branch - date). 

 

Figure 1 File location for installing IES software. 

 

It is then suggested to save models using the same naming convention, so one can know which build 

the model was created with, e.g., iVN 2021_3_0 - 192897 (FB1 - 10122021) - [model name] (see 

screenshot of saved models). 

 

Figure 2 Naming convention advised for model saving. 

 

4. Install IES iSCAN 
• Access and sign into iSCAN using your iesve.com username and password (web application 

https://iscan.iesve.com/). 

https://www.iesve.com/support/ivn
https://bits.zynbit.com/link?guid=83d04f78-d6d0-4df6-8cd5-ad57d6896539&url=https://urldefense.proofpoint.com/v2/url?u=https-3A__iscan.iesve.com_&d=DwMFAg&c=KWFQGcMK0IJkSyjAXKqofg&r=nPUbFrpE9ll3KY8826Mz3w5nYNlyZ-afWWnKr838dXw&m=EOV0COmQpOMhNKJO20djFvtOUMMJ2vLBtPZDkvVBi9M&s=l8myAkuwIP1Fq5t-izouNZkxwHLpFJrbBNx-octpH1A&e=
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• A few videos to get you going: https://www.iesve.com/icl/iscan/trial and 
https://www.youtube.com/watch?v=34H1d0kBlaQ&feature=youtu.be 

• Free Training can be found here https://distance-learning.iesve.com/p/iscan. You will need 
to enrol and/or login to IES Distance learning to access. 

• There is also an online support section containing lots of getting started resources here 
https://www.iesve.com/support/iscan  
 

5. Install IES iCIM 
• You can access the trial dashboard through this link - https://icim-trial.iesve.com/icim 

• You will need your standard iesve.com login.  

• There is also an online support section containing lots of getting started resources here 
https://www.iesve.com/support/icim  

 

 

  

https://bits.zynbit.com/link?guid=3b1dced0-ff0c-4de4-9d6e-1fcbec6f50af&url=https://urldefense.proofpoint.com/v2/url?u=https-3A__www.iesve.com_icl_iscan_trial&d=DwMFAg&c=KWFQGcMK0IJkSyjAXKqofg&r=nPUbFrpE9ll3KY8826Mz3w5nYNlyZ-afWWnKr838dXw&m=EOV0COmQpOMhNKJO20djFvtOUMMJ2vLBtPZDkvVBi9M&s=Li5Yj2Dlbfwbq7o4971rqVPKp0AN25SviAdMSYLJBJI&e=
https://www.youtube.com/watch?v=34H1d0kBlaQ&feature=youtu.be
https://distance-learning.iesve.com/p/iscan
https://www.iesve.com/support/iscan
https://icim-trial.iesve.com/icim
https://www.iesve.com/support/icim
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Section B Waste Heat/Cooling potential for a single 
industrial/manufacturing site 

This section relates to the steps required by the user to collect and organise data that exists for the 

building(s) and is required to calculate potential waste heat /cooling resources. 

1. Identify and collect relevant data 
Data is at the basis of an initial identification and assessment of the WH/C resource potential 

available. To aid the understanding of what data is required and available, the prior completion of a 

building data checklist should be conducted (see Annex A). 

The areas for which information is required are: 

• Industrial site information; 

• Waste heat/cold recovery & Renewable heat/cold and electricity; 

• Industrial site processes information; 

• Industrial site services information; 

• Automated Meter Reading (AMR) data and energy costs information; 

• General building information. 

Once the data available has been established, and collected, there are different routes the user 

should take in order to get to the answer of waste heat/cooling potential, depending on what data 

they have. 

These routes (also known as Data Use Cases) are identified and depending on the type of operational 

data that can be shared from each facility (i.e. utility bill, partial or detailed sub-metering data, or a 

combination of these) a generic stepped modelling path is followed towards an initial identification 

and assessment of their respective WH/C resource potential, as further detailed below, including a 

brief explanation for each step of the generic modelling path. 

For each of the 5 use cases, an associated set of minimum additional information required is defined, 

as can be seen in Figure 3. Following on from an analysis of completed demo-site data checklists, one 

of the use cases listed in Figure 3 is identified for each demo site, which allows for assessing whether 

minimum data requirements are met for an assessment of WH/C resource potential through existing 

modelling tools, and which provides further details on the subsequent modelling path steps.  

Use 
case 
no. 

Data available Minimum additional information required 

1 
Utility bill 
data only 

• Description of processes & services via diagrams or otherwise 

• Description of inputs & outputs, product flows / temperatures, production 
calendar 

• High-level information on daily profiles to inform rough-cut profiles 

2 
Partial 
sub-metering 

only 

• Description of processes & services via diagrams or otherwise 

• Description of inputs & outputs, product flows / temperatures, production 
calendar 

• High-level information on daily profiles to inform rough-cut profiles, where 
required 
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Use 
case 
no. 

Data available Minimum additional information required 

• Information on what inputs/outputs the sub-metering relates to 

3 
Utility bill & partial 
sub-metering 

• Description of processes & services via diagrams or otherwise 

• Description of inputs & outputs, product flows / temperatures, production 
calendar 

• High-level information on daily profiles to inform rough-cut profiles 

• Information on what inputs/outputs the sub-metering relates to 

4 
Detailed 

sub-metering time 
series 

• Description of processes & services via diagrams or otherwise 

• Description of inputs & outputs 

• Information on what inputs/outputs the sub-metering relates to 

5 
Utility bill & detailed 

sub-metering time 
series 

• Description of processes & services via diagrams or otherwise 

• Description of inputs & outputs 

• Information on what inputs/outputs the sub-metering relates to 

Figure 3 Recommended use case identification matrix. 

 

2. Data formatting, upload to iSCAN, mapping and/or pre-processing 
Relevant data is extracted from collected data sources (e.g. energy audit report) and/or data format 

is adjusted so that it can be integrated into existing SO WHAT modelling tools, in particular for time-

series operational data (from utility bills or sub-metering systems). 

The data processing platform (iSCAN) requires time series data, but with various formats (e.g., csv) 

available and a broad range of time resolutions (e.g. from 1 year to 1 minute).  

 

Figure 4 Example of time series data in CSV which can be imported into iSCAN. 

 

Formatted time-series operational data is then uploaded to online data visualisation and processing 

platform (iSCAN). 

Start Date End date Me0 M0 M1 M2 M3 M4 M5 M6 M7 M8 M9 M10 M11

2018-01-01 2018-01-31 953221 953221 16827 1618 162773 1387 19926 407 43591 102055 3871 9192 39846

2018-02-01 2018-02-28 829232 829232 11484 1412 111569 1461 18933 465 30035 95017 3704 8642 37513

2018-03-01 2018-03-31 972635 972635 19134 1679 136300 1400 20024 471 50042 105283 4418 11174 30658

2018-04-01 2018-04-30 772062 772062 13254 1419 103981 682 16826 487 34664 84573 4471 9027 16884

2018-05-01 2018-05-31 996217 996217 16449 1516 150913 942 18077 2039 43020 122720 5307 9445 19820

2018-06-01 2018-06-30 1120758 879753 13448 1488 169929 377 18403 4127 35117 101046 4748 7881 20414

2018-07-01 2018-07-31 1426135 996840 41927 1395 208195 436 19986 6832 41927 131632 5328 8646 22210

2018-08-01 2018-08-31 1037283 792013 24347 858 33910 275 18393 6294 24347 115491 3581 7713 19073

2018-09-01 2018-09-30 1462522 1084302 38597 1399 322229 1204 18158 1703 38597 148401 5064 11374 22657

2018-10-01 2018-10-31 1178994 758244 37671 1134 126304 1709 17487 542 37671 121879 4961 13196 26911

2018-11-01 2018-11-30 1126943 773393 44176 1167 189186 742 16908 491 44176 86368 5610 12955 26607

2018-12-01 2018-12-31 881014 595384 32850 809 86017 1154 18388 417 32850 97471 272 12054 24416
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To begin go the iSCAN webpage, add your project, and then add buildings within the site. It is 

important to keep the building names consistent between IES platforms to allow effective data 

communication and modelling. 

After this, project building can have relevant time series data imported and linked to them. 

 

Figure 5 How to begin importing data into iSCAN. 

 

 

Figure 6 iSCAN data import configuration wizard. 
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Uploaded time-series operational data channels are then tagged and mapped across diverse types of 

energy (e.g., electricity, natural gas, etc.), process, end-use, etc. 

Go through the steps of the data source configuration wizard to upload the relevant data profile. 

1. Introduction: explains some points such as input format types and how this may relate to 

the data that is available to upload. Refer back to this page if required. 

2. New data source: give the data import a relevant and useful reference name. Select the 

type of data that is to be uploaded (most BMS and time series data will be CSV – column 

per channel). 

3. Data source set-up: Ensure Keep uploads, Timestamp in input files use local time, and 

Timestamps use daylight savings (if necessary) are checked while Use time of upload as 

timestamp for data should remain unchecked. 

4. Example Data: Select the data file to be uploaded and click Process file format (this may 

take some time if the file is large). 

5. Configure format: Headers in grey and red, timestamp data is represented in blue, value 

data in yellow. This shows an example of the data imported where it can be viewed that 

the example data import was successful and in the correct format. If this needs to be 

amended it can be done so by selecting the relevant cell and selecting from the drop 

down list the relevant type. The setting button also gives more insight to different details 

although this should not need to be used. Click the blue continue button to move to the 

next page. 

6. Data Binding: As this is a new project the data will not have been bound to any previous 

uploaded data. As shown in the image below simply select the check box by the bindings 

column header to select all data points and click the Create channel button to assign the 

default name for each data point (the same name as in the import file header) and click 

the Save Changes button on the pop up. 

7. Summary: Click the Upload files button and from the pop up select the data file for upload 

then click import data. 



 

Deliverable 4.8 SO WHAT Manual 
Page 16 of 66 

  
 
 

This project has received funding from  

the European Union’s Horizon 2020 research and innovation 

programme under grant agreement No 847097 

Security level: RINA/CL/SENSITIVE 

 

Figure 7 Data binding page within the iSCAN data import wizard. 

 

After these steps your data set should be uploaded successfully. It is best to give a quick review to the 

data that has been uploaded. Select the investigate drop down and select Visualise where all the data 

points can be seen under Channels. 

 

Figure 8 Visualising the data imported to iSCAN. 

 

A small star next to the channel name notes that the units have not been defined for this data point. 

Select the Data drop down and go to the Channel list to review all the channels (data points) and 
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assign relevant information and details to them. It is advised that the Name be changed to a custom 

name to make this easily recognisable and better describe the channel. Also, the Level and Units 

boxes should have the relevant information put into them. Once the Units box is filled the star by the 

channel name will be removed. 

The Expression box at the bottom allows mathematical expressions to be written for custom data 

points (such as adding all electrical meter data to have a singular total electrical usage for the 

building), the Syntax button will detail various expression that can be written and provide examples 

of these. 

Sample type represents the type of data that has been imported for this specific data channel. For 

metered data the Metered Value is best suited although the Average type is often appropriate and 

most flexible for imported data, there is a help (“?”) icon which can be clicked and describes the other 

sample types in detail to allow the most appropriate to be selected. For more information on this the 

IES Learning video under iSCAN → Data Import will provide guidance on the various types and these 

steps. 

In the example below, submeter “C0” logs lighting kW usage in the example building. The name is 

changed to reflect this and the level is noted as Energy while Power kW has been assigned as the 

Units. As this is sub-metered data the Metered Value option has been selected as the sample type 

with an Expected Period of 60 minutes as this is the time samples the metered data has been 

recorded in (energy readings are recorded hourly for this example data). Sample type of Metered 

Value will allow iSCAN to calculate the rate of change over the expected period (60 mins). 

 

Figure 9 Channel list setting to define specific detials to imported data (meter data in this example). 

 

3. Rough-cut profiling and/or data processing and/or upload to iSCAN 
This is applicable for use cases 1, 2 and 3, see Figure 3. Where necessary, rough-cut profiling technique 

(available through the existing “Utility Bills” module from the IES iSCAN online data collection and 

processing platform) is used to develop more detailed facility's energy consumption and generation 

https://distance-learning.iesve.com/courses
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profiles (preferably at hourly intervals) from available low-resolution data such as monthly or annual 

utility bills. 

An example of the rough-cut profile creation process is shown below: 

Monthly energy consumption or generation data (kWh, as exemplified for sub-meter “M3”) 

converted into energy demand or supply (kW, as exemplified for sub-meter “M3”) profiles, with a 1-

hour time resolution, for each of the 68 meters and sub-meters available from the demo site data 

sources. This is achieved by distributing the metered / sub-metered monthly energy consumption / 

generation (kWh) into their associated load operational schedule, and constrained by their respective 

rated power (kW), as exemplified for sub-meter “M3” in the figure below. 

  

Figure 10 Rough-cut profiling for the demo-site, energy consumption on a monthly basis. 

 

  

Figure 11 Rough-cut profiling for the demo-site, energy consumption on an hourly basis. 
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Figure 12 Rough-cut profiling for the demo-site, operational schedule questionnaire. 

 

Subsequent data processing is applicable for all demo sites, but less resource-intensive and more 

accurate for use cases 4 and 5, Figure 3. Collected and uploaded time series operational data are 

further processed in to generate energy input and heat output profiles, including waste heat and cold, 

for industrial processes and process components of interest. This can be achieved offline or directly 

through the IES iSCAN online data processing platform, by implementing mathematical 

“Expressions” (i.e., formulas) on the collected data. Such mathematical “Expressions” vary in terms 

of complexity and are specific to each demo-site, depending on the collected data types and 

depending on whether “rough-cut” profiling was necessary or not. It should be noted that such a step 

might even be bypassed in cases where collected data already include all the process energy input 

and output profiles, including waste heat and cold, which are necessary for the development of an 

Energy Sankey diagram. On the opposite, such a step might be quite resource-intensive by requiring 

the use of external databases, in addition to the data available from a demo site, such as 

thermophysical properties of common energy conveyor mediums (e.g., air, steam, water, gases, 

etc.). 

4. Produce results and visualisation for potential Waste Heat/Cooling 
This is relevant to the 5 use cases that are detailed in Figure 3. Subsequent to data rough-cut profiling 

and processing that enabled to generate energy input and output profiles for industrial processes and 

process components of interest, including waste heat and cold, there are two ways to visualise an 

overall industrial site waste heat and cold resource. 



 

Deliverable 4.8 SO WHAT Manual 
Page 20 of 66 

  
 
 

This project has received funding from  

the European Union’s Horizon 2020 research and innovation 

programme under grant agreement No 847097 

Security level: RINA/CL/SENSITIVE 

On the one hand, this can be achieved directly through the IES iSCAN online data processing 

platform, by implementing mathematical “Expressions” (i.e., formulas) in order to aggregate the pre-

processed energy input and heat output profiles, including waste heat and cold, for industrial 

processes and process components of interest, at a whole site level and with a 1-hour time resolution. 

An example of such a waste heat/cold resource profile visualisation can be seen in Figure 13 below. 

 

Figure 13 Example of demo-site aggregated waste heat resource profile, with a 1-hour time resolution (iSCAN) 

 

On the other hand, this can be achieved through the development of an Energy Sankey diagram. To 

do so, a building energy simulation model of the facility (construction and HVAC systems, if 

necessary) needs to be created first through the IES VE detailed building energy modelling and 

simulation platform, where a sufficient level of general building information was previously collected 

from industrial demo sites, as based upon the prior completion of a building data checklist (see Annex 

A). Alternatively, a simplified standard building model can be used instead, with adjustments 

possible, in particular for weather conditions, as illustrated in the Figure 14 below. Then, process 

models of the internal manufacturing lines of interest, at a process or component scale, can be 

created. However it should be noted that processes are not modelled as physics-based models, but 

rather as data-based models represented by a single or a series of components. Furthermore, the 

visual representation of these components can be adjusted or designed from scratch, but here simply 

represented by a box for each process considered, as exemplified in Figure 15 below. Subsequently, 

Creation and population of process databases, in particular energy inputs and heat outputs (including 

waste heat) time series operational data. Once processes are modelled by one or a series of 

components, energy input and output profiles that were previously processed in iSCAN can be 

associated with relevant components, as well energy inputs from building model HVAC systems 
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(including RES systems), if these are modelled, as exemplified in Figure 16 for a SO WHAT project 

demo site. Annual building energy simulation is then performed through the VE and existing tool 

scripts are used for visualisation of process energy flows through an Energy Sankey diagram, as 

illustrated in Figure 17 below for a SO WHAT project demo site. In particular, the Energy Sankey 

diagram considers the energy and heat/cooling flows in the factory and is created around several 

column headings. Each heading represents a column of nodes which are built up from the model data 

the user has entered in the manufacturing view. Each heading relates to the following elements 

within the manufacturing view: Source (i.e. Fuels), HVAC Plant Convertors (i.e. IES VE Apache 

Systems), System Load (i.e. Load developed on the systems), Use/Demand Sinks (i.e. Component 

variables), Process Converters (i.e. Components), Sinks (i.e. Products & Waste heat removal). 

 

 

Figure 14 Simplified standard demo-site building model 

 

 

Figure 15 Example of demo-site process component model 
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Figure 16 Data syncing of process energy inputs (on top) and process waste heat energy output (at the bottom) 

Process Name 

Max. Flow Rate 

Product Name 

Profile Name 
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Max. Flow Rate 

Product Name 

Profile Name 
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Figure 17 Example Energy Sankey diagram for a SO WHAT project demo site 

 

5. Set up and simulation of Waste Heat/Cooling recovery and exploitation 
technologies for use in industrial facility 

Once the potential waste heat in the industrial facility is known, and the user has a good idea of which 

technology they wish to simulate, a baseline model of the site’s energy demand and carbon emissions 

is required in order to allow the simulation to give valid results. 

5.1 Set up baseline model of industrial site 
A baseline model is fundamental to understand the current energy demand and carbon emissions of 

the block under assessment and to assist in the potential for any waste heat or cooling recovery for 

use internally and within the community. 
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First, a 3D model of the block under assessment needs to be created. The iCD tool allows several file 

formats to be imported, including Shapefiles and GeoJSON files. If the geometries of the buildings in 

the block are available into any of those formats, you can import them as shown below. 

 

Figure 18 Shapefile and GeoJSON file import. 

 

If those formats are not available, which is often the case, the iCD gives the user the possibility to 

import buildings from Open Street Map (OSM). The OSM database can contain higher or lower level 

of detail depending on the site location, but it normally gives a good basis upon which building the 

initial model. Click on the OSM import button and import the area needed for the project. 

 

Figure 19 Importing from OSM to iCD. 
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Once the import from OSM is complete, the buildings will appear within the model as well as the map 

tiles and roads, if selected during the import process. At this point, the user needs to start addressing 

the building geometries within SketchUp/iCD model. Where OSM does not have a certain info (e.g. 

number of storeys of a building), a default building height will be assigned instead. The same for 

glazing ratios, roof types and more. For such reason, it is fundamental that the user addresses each 

building and manually modifies each parameter that seems to be inaccurate, based on the 

information they are able to collect. 

With a baseline model in place the user needs to ensure the building geometries are correct. Where 

there hasn’t been certain info provided (e.g. number of storeys of a building), a default building height 

will be assigned instead. The same for glazing ratios, roof types and more. For such reason, it is 

fundamental that the user addresses each building and manually modifies each parameter that 

seems to be inaccurate, based on the information they are able to collect. 

In order to do so, click on a building and open the object parameters. Every attribute of the building 

can be changed manually. You should aim to reach the most accurate level of detail you can possibly 

reach, in order for your baseline to be a realistic representation of the actual block. 

 

Figure 20 Editing building details in iCD. 

 

Once enough input data has been assigned to the model to represent as close as possible the real set 

of buildings, it is time to run energy simulations in order to get demand profiles of the buildings and 

have an estimation on their energy and carbon footprints. 
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Before simulating, it is important to link the iCD to a project in iSCAN. This will allow the user to 

export simulated data into the iSCAN platform for each building straight after an energy simulation 

has been carried out. To link the iCD to iSCAN, first login into iSCAN and create a new project. Give 

it a name, and add any additional user that might need to collaborate on the same project from the 

‘Project users’ page. 

The newly created project now needs to be connected to the iCD in order for data to be streaming 

from one tool to the other. To do so, from the iCD go into Extensions → IES iCD → IES iSCAN Client 

→ Setup Endpoints and Token. Here, add the scan project url and token, then click on Save. Note 

that the url and token can be retrieved from iSCAN within the ‘API tokens’ page of your new project. 

If there are no tokens created yet, you can create a new one by clicking on ‘Create token’, and then 

copy that into the iCD. Make sure to select the ‘maintainer role’ when creating the token. 

 

Figure 21 iCD connection to iSCAN. 

 

 

Figure 22 iSCAN Project token and url. 
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Before running energy simulations, give a specific name to the buildings in the block. As noted 

previously it is important to keep the same building names across platforms and models to allow for 

seamless integration of the models and data. This will help recognising the demand profiles of each 

building once they will be exported into iSCAN. 

Also, it is important to set the CO2 emission factors and costs according to the specific country in 

which your model is located. To do so, go into Extensions → IES iCD → Preferences and set tariffs 

and emissions according to your knowledge. If not known, you can leave them by default as per UK 

dataset. 

 

 

Figure 23 Carbon emission factors and Tariffs. 

 

It is now all set to start running energy simulations from the iCD tool. In order to do so, select one or 

multiple buildings and click on the VE simulation button within the iCD toolbar, select your simulation 

preferences, hit ‘update’ then ‘Launch’. Remember to tick the ‘Export’ button if you wish to push the 

time series demands into iSCAN. You will also need to select the iSCAN project to which you want to 

send results to, from the dropdown menu. 
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Figure 24 Running basic energy simulations in iCD. 

 

If the simulation has not already exported the results to iSCAN the below option should appear after 

the simulation and the project and endpoints can be selected if an error has occurred. 

 

Figure 25 Exporting iCD simulated results to iSCAN. 

 

Once the energy simulation has finished running for your building (or set of buildings), you will see 

results being exported into iSCAN. At the end of the process, a new building will be created into the 

iSCAN project, with the same name of your iCD project, as seen in Figure 26. Within that building, all 
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relevant time series channels will be created, with a clear naming formed by the name of the specific 

building and the name of the variable. Summary values of energy demand data will also be shown 

within the iCD, into the building properties. 

 

Figure 26 iSCAN project homepage. 

 

In iSCAN, use the “Investigate” tab to review the data over a time series that has been simulated for 

this building.  

 

Figure 27 Visualising exported iCD simulation results in iSCAN 

 

Basic energy simulation results can also be reviewed in iCD after the energy simulation has been 

completed. While the desired building is selected click the Room/Building Query button and scroll to 

the Simulation Results section. 
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Figure 28 Reviewing the simulated energy totals within the iCD building viewer. 

 

A report for all the buildings that have been simulated can also be reviewed by going into Extensions 

→ Reports → Energy Reports → Full Energy Reports. To note this is a model level report rather than 

a building level report. Other reports can also be reviewed in this section that may be of interest. 

 

Figure 29 Full energy report from the iCD simulation. 
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5.2 Export data from iSCAN to iCD 
Section B.2 details how meter data can be uploaded to iSCAN. After meter data has been uploaded 

and connected to iSCAN the exporting of this data to the iCD model will allow for analysis in iCD and 

greater model accuracy and detail. 

Tags made in iSCAN for relevant buildings in iCD must have the same name between the 2 platforms. 

Ensure that either the iCD model has the same buildings name as detailed in iSCAN or the reverse of 

this.  

In iSCAN select the Tag vocabularies option in the project menu page. On the next page click the 

Create Tag Vocabulary at the bottom left of the page. 

 

Figure 30 Setting up tag vocabularies in iSCAN to link data to relevant buildings. 

 

Two Tag Vocabularies will need to be made. The first under Building Names and the second under 

Variables. Building Names will contain a list of the building names for this project. The Variables will 

contain the metered data for the buildings and site. Using both of these identifiers it will be possible 

to assign metered data to the relevant building in the iCD model. To note, the tags in the Building 

Names Vocabulary must be the same as the building names in the iCD model. 

Select the Buildings tag you have created and select Create Tag in the bottom left of the page. Now 

enter a building name for one that is in your project site. Repeat this step for all building you intend 

to model in your project. Once done this will similarly be repeated in the Variables Tag Vocabulary 

you have created. For this example, Metered Lighting will be imported (as shown in section TO1.2), 

although this will need to be repeated for other data that is to be exported. 
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Figure 31 iSCAN tag creation. 

 

It is now necessary to return to the project list page, select the project, and then the Channels List 

under the Data drop down to return to our metered data that has been imported to iSCAN. Select the 

data point within the Channel List (in this example it is the Electrical Submeter C0 – Lighting) and 

select the Tags option. Within this page select Add Tag and add the building and then variable that 

were previously created in Tag Vocabularies. 

 

Figure 32 Assigning variable and building tags to relevant data in the iSACN channel list. 
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The iCD model building and the iSCAN data now need to be linked if this has not already been done. 

Return to the Projects List page and select the API Tokens button. Here a token should be created 

under the Maintainer role. 

 

Figure 33 Creating tokens in iSCAN to link the iSCAN data to the iCD model. 

 

Return to the iCD model and select Extensions→IES iSCAN Client→ Setupn Endpoints and Tokens. 

Paste the URL from iSCAN into the Add project box and copy the iSCAN token into the Add token 

box. 

Now it is possible to link the tags made in iSCAN to the iCD model. Click Extensions→IES iSCAN 

Client→Channel Associations. The IES iSCAN Channels box will pop up, select the Match button and 

then select Save. To view the results and that the import has been done correctly, in iCD select the 

relevant building, click the Room/Building Query button and scroll to the User Defined section and 

find the relevant meter data variable that has been imported. 
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Figure 34 Linking the iCD model to iSCAN. 

 

 

Figure 35 Matching the correct iSCAN channels to iCD. 

 

5.3 Synchronisation of iCD data with iCIM model 
In order to use the Network tool, we need to bring a copy of our iCD model onto the iVN model. This 

cannot be done through a simple export/import but needs to be done by first exporting the iCD model 

onto the cloud. 

To do so, from the iCD toolbar, click on the ‘Synchronise’ button, add the iCIM url as a new endpoint, 

and then add a new project, as seen in Figure 36 and Figure 37 below. Enter a project name and 

description (optional), and click on ‘Create’ to synchronise your model to the cloud. This will create a 
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new project on the iCIM, permanently linked to your desktop version of the model. From this point 

on, any change made to the iCD model can be sent to the cloud model by simply clicking again on the 

synchronise button and send the changes. This is also useful when multiple users are working on a 

single model, so that they can send/download changes to the cloud to always work on the most 

updated model. 

In order to enable a successful iCD/iCIM synchronisation, all the landscaping objects (Water bodies, 

Soft Landscape, Hard Landscape), in particular the largest water body object, should be removed 

from the iCD model. Although these objects can be included into an iCD model prior to be 

synchronised with an iCIM model, the large size of some of these objects (e.g. water body objects) 

may create a size issue when synchronising with iCIM. 

 

Figure 36 Synching the iCD model to iCIM. 

 

 

Figure 37 Setting up the endpoints between iCIM and iCD to link them. 
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With regards the iCIM url endpoint, it should be noted that enabling of dangerous operations is not 

necessary, and the following iCIM Trial endpoint should be setup (https://icim.iesve.com/trial/cim or 

https://icim.iesve.com/trial/gfc), as per Figure 38 below. 

 

Figure 38 Final step in linking iCD and iCIM models. 

 

In this way, iCIM models that are synchronised with iCD models can be accessed in iCIM Trial here 

https://icim.iesve.com/trial/#/. 

6. Identify and select technologies to recover and reuse waste 
heat/cooling  

A wide range of waste heat and cold (WH/C) recovery technologies in industry are presently available 

in the software. They greatly differ in terms of operating principle and operating conditions, target 

applications, development stage, costs and benefits.  

These technologies were assigned to five main categories: 

1. Heat-to-heat technologies. 

2. Thermal energy storage technologies. 

3. Waste heat to cold technologies. 

4. Heat to power technologies. 

5. Heat upgrade technologies.  

https://icim.iesve.com/trial/#/
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The image below details the findings from research conducted to identify technologies with potential 

use in the various SO WHAT project sites for waste heat/cooling recycling.  

 

Figure 39 Waste energy technologies identified for the SO WHAT project. 

 

Discussion should occur internally within the user’s organisation to select which technologies are 

most suitable to the use’s context. To aid this, the SO WHAT project has produced number of 

documents as follows: 

D2.6 - Scenarios to be covered by the SO WHAT tool 

D1.6 - WH/C recovery and thermal storage technologies 

Within the D2.6 document, the project produced a methodology and scenarios to help guide the 

users on their selection. The following sub sections are an overview of this. 

6.1 SO WHAT methodology for selecting technologies 
The methodology for the hierarchy of scenarios was designed in order to guide the different users to 

view and choose the most appropriate technologies and combinations that suite their context and 

requirements. It will be used in the development of the SO WHAT tool whereby the scenarios 

available to choose from will be dependent on the type of user and the version (Free or Commercial) 

they are using.  The methodology is numbered sequentially, however there are many different sub 

scenarios grouped under one main theme and a number of them will only apply to specific user types. 

The methodology is based on the principles of reducing waste as much as possible, before recovering 

waste and reusing in the most efficient ways.  It is summarized in the following 6 stages (Figure 40), 

which are described in further detail below, whereas the full lists of scenarios for each of these 6 

stages can be found in Table 2 of the previously submitted deliverable report D2.6 - Scenarios to be 

covered by the SO WHAT tool. 

https://sowhatproject.eu/wp-content/uploads/2018/05/Scenarios-to-be-covered-by-the-SO-WHAT-tool.pdf
https://sowhatproject.eu/wp-content/uploads/2018/05/SO-WHAT_D1.6_Report-on-HC-recoverystorage-technologies-and-renewable-technologies_FINAL_updateMARCH2021.pdf
https://sowhatproject.eu/wp-content/uploads/2018/05/Scenarios-to-be-covered-by-the-SO-WHAT-tool.pdf
https://sowhatproject.eu/wp-content/uploads/2018/05/Scenarios-to-be-covered-by-the-SO-WHAT-tool.pdf
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Figure 40 Scenario Selection Hierarchy 

 

Stage 1: Baseline waste heat/cooling potential of facility/community 

Although a ‘scenario’ is defined as a potential future state, the user must first have conducted a 

baseline simulation of the current state of waste heat/cooling potential and so this is considered as 

the top in the hierarchy and first scenario to consider. In both the free and commercial versions of the 

SO WHAT tool, this step will be done before the user is able to go through the other future scenarios. 

There are 3 Scenarios associated with this stage (see Table 2 of the previously submitted deliverable 

report D2.6 - Scenarios to be covered by the SO WHAT tool). 

Stage 2: Reduce energy use and eliminate waste heat/cooling 

This stage of the scenario hierarchy is not directly the focus of SO WHAT, nonetheless it is a logical 

and necessary step that the user should consider and decide whether to conduct before moving to 

explore waste heat/cooling recovery and distribution. As the overall aim of reusing waste heat or 

cooling is to reduce the amount of resources utilised and cut down on carbon emissions, the industrial 

user of one facility should therefore try to improve the overall energy efficiency of their building 

before looking specifically at waste heat/cooling. In the software (as explained in D2.3), there will be 

a link in the commercial tool into IES VE to enable the user to conduct detailed energy performance 

simulations of their facility and analyse the best energy efficiency strategies for the whole building.  

Similarly, the user of that facility should also look to completely eliminate waste heat/cooling from 

their process before trying to understand recovery potential. This is explained using Kaizen 

techniques. It should be noted this analysis is not part of SO WHAT, but was a key focus of a prior EU 

FP7-NMP funded project REEMAIN.  

Stage 3: Recover and reuse waste heat/cooling at a factory level 

This relates to the recovery of waste heat/cooling to be re-used in the factory. Firstly, the user should 

look at whether they can re-use the waste within the same process as this will be the most efficient 

https://sowhatproject.eu/wp-content/uploads/2018/05/Scenarios-to-be-covered-by-the-SO-WHAT-tool.pdf
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way to initially utilise resources, before analysing further on how utilise it in a different process in the 

facility. There are 16 Scenarios associated to this stage which describe the different technologies to 

recover waste heat, and how it can be reused as heat in the factory processes (see Table 2 of the 

previously submitted deliverable report D2.6 - Scenarios to be covered by the SO WHAT tool). 

Stage 4: Recover and reuse waste heat/cooling to provide power at a factory level 

Stage 4 continues within the factory, albeit this time to generate power rather than solely thermal 

energy. There are a further 4 Scenarios associated with this Stage (see Table 2 of the previously 

submitted deliverable report D2.6 - Scenarios to be covered by the SO WHAT tool) relating to general 

guidance on how to generate power and how to add solar panels/solar collectors, as well as more 

specific guidance on maximising the use of renewable energy and the optimal mix of different 

installations. 

Stage 5: Recover and reuse waste heat/cooling at a community level  

Stage 5 moves to the scenarios at a community level in terms of the recovery of waste heat/cooling 

from industry. After analysing the previous stages, if the user wishes to move to this stage, they 

should move to Section C for details on how to conduct this simulation. The first scenario concerns 

the overall matching of supply and demand, and then other scenarios look at how either a district 

heating network, or another means of transport, could be used to distribute the waste heat to the 

consumer. There is also a scenario related to the storage of waste heat so that it can be used at a later 

date, as well as two other scenarios that allow the user to conduct a cost benefit analysis of expanding 

a district h/c network, or constructing a new one, to connect to newly identified waste heat sources 

and users.  

Stage 6: Recover and reuse waste heat/cooling to provide power at a community level. 

The final Stage relates to recovering waste heat/cooling from an industry and then converting this to 

produce electricity to be used either by other local buildings as part of a micro grid, or to be sold and 

used by the national grid. After analysing the previous stages, if the user wishes to move to this stage, 

they should move to Section C for details on how to conduct this simulation 

6.2 Simulation of Waste Heat/Cooling recovery for industrial site 
The IES iVN (Intelligent Virtual Network) is designed to perform "as-is" and future scenario 

simulations of a community's energy demand and supply distribution network. In the SO WHAT 

project, the ability of the iVN to model and simulate heat flows and networks can be created, allowing 

for the ability to simulate different waste heat and cooling technologies. 

The iVN can provide for the following capabilities: 

• Modelling a range of technologies for recovering and reusing waste heat and waste cooling. 

• Model the District heating and cooling infrastructure network and run simulations. 

• Reporting improvements and analysis to show where opportunities exist to supply a 

community with excess WH/C and integrate with renewables. 

• Potential demand response flexibility - identify what times demand response could be used 

to reduce the load-mismatch between available WH/RES and demand.  

• Allow user to export iVN data to the iSCAN e.g. for access by the SO WHAT dashboard. 

https://sowhatproject.eu/wp-content/uploads/2018/05/Scenarios-to-be-covered-by-the-SO-WHAT-tool.pdf
https://sowhatproject.eu/wp-content/uploads/2018/05/Scenarios-to-be-covered-by-the-SO-WHAT-tool.pdf
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6.2.1 Setup iVN project parameters 

Now that a copy of the model is stored in the iCIM cloud platform, it is possible to bring that directly 

into the iVN Network tool. To do so, open the iVN and go into Import > iCIM Link. In the iCIM Endpoint 

box enter the following link: https://icim.iesve.com/trial/gfc/ and press the Load Projects button. 

After this you will need to enter your access credentials where it will allow you to view a list of projects 

that you have access to on iCIM. Select the relevant iCIM project and ensure the ‘Sync building results’ 

box is ticked and that the date range includes data from the dates for which you wish to simulate, 

then click the import button on the bottom right of the page. 

 

Figure 41 Importing iCIM model to iVN. 

 

Once the process is completed, the 3D model will appear, representing an exact copy of the project 

crated within the iCD. The buildings that have been simulated will also contain time-series demand 

data, according to the dynamic energy simulation run into the iCD. 

As an iCD model (including building geometry from OSM and custom adjustment made by the user) 

and iSCAN data should already be linked to the iCIM model, this information should be automatically 

imported to the iVN model from the iCIM model. The image below shows the successful importing of 

data from the iCIM model as used as an example previously in this project. Note how this building 

geometry matches that from the iCD and iCIM models. 

 

Figure 42 3D visual of iVN model once iCD model has been imported. 

https://icim.iesve.com/trial/gfc/
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If some of the information with regards to building geometry needs to be corrected or updated it can 

be edited in the Data Inspector tab of the selected building. Click the Analysis Inspector tab to review 

that the data from iSCAN and simulated results have been correctly imported to the iVN model. 

Charts and tables with the iSCAN data should be visible and populated accordingly. 

 

Figure 43 Data inspector tab where building details can be amended. 

 

If additional iSCAN data needs to be connected to the iVN model due to either more recent data 

being collected or the import has not been done effectively it is possible to connect the iVN directly 

to the current iSCAN profiles. To do this click the Homepages button as circled below. 

 

Figure 44 iVN homepage button. 
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Click the Import button and the iSCAN link option. Similarly, in Section B.5.2 regarding creating 

iSCAN API tokens for linking data between iSCAN and iCD an API token with a reference link must 

be entered here. Add the iSCAN token and link URL and a list of the channels from iSCAN in the 

relevant boxes in the iVN Homepage Import section and select the building(s) and channel(s) as 

required. Multiple buildings and channels can be selected to import. Ensure the date range is correct 

to include all the data that is required from iSCAN. 

 

Figure 45 How to import iSCAN data (if required and updated iSCAN data is available). 

 

Other key parameters to set up in iVN at a model project level, prior to progressing with the modelling 

of iVN baseline and scenario network models, include the following: 

• Weather File: In order to visualise the current weather file in use, from the object browser, 

left click on the imported model project name, and expand the Model Location section in the 

Data Inspector. By default, the “heathrowewy.fwt” weather file should be the only one 

available, which is relevant to weather data for the UK London Heathrow airport weather 

station. In order to adjust the weather file for a more appropriate location than the UK 

London Heathrow airport, weather file(s) of interest first needs to be imported into the iVN 

model. To do so, click the Homepages button (Figure 44), then the Import button and the 

Weather Data link option (Figure 45), prior to selecting the browse button that will 

automatically open the iVN software installation folder where the list of Weather Files 

installed by default can be browsed. Select one or multiple weather files of interest and 

complete import by clicking on the import button. Once import is complete, from the object 

browser, left click on the imported model project name, and expand the Model Location 

section in the Data Inspector in order to select the weather file to use. More details on 

simulation Weather Files can be found here https://www.iesve.com/support/weatherfiles. 

• Project commodities (fuels) carbon dioxide emission factors: In order to visualise and amend 

the imported model project carbon dioxide emission factors for each of the project 

https://www.iesve.com/support/weatherfiles
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commodities (fuels), from the object browser, expand the list of Project commodities and 

left click on the fuel of interest, for which the CO2 factor for consumption (kg/kWh) can be 

seen in the Data Inspector. By default, values relevant to the UK are set. These can be 

amended by left clicking on the CO2 factor for consumption (kg/kWh) value cell and by 

entering a more appropriate value for the country and year of interest. 

It is strongly advised to set the same Weather File and Project commodities (fuels) carbon dioxide 

emission factors in iVN as the parameters previously set up in iCD, in order to ensure consistency in 

energy and carbon emission results, as simulated through both the iCD and the iVN platforms. 

 

6.2.2 iVN baseline network model 

The modelling of the electricity, heating and cooling networks is split into two methods, the virtual 

and physical networks: 

• The virtual network modelling provides simple Hierarchical Demand Aggregation and 

Supply Allocation (HDASA) whereby waste heat network nodes represent the points in the 

network where the demand for commodities is aggregated at a node and the allocation of 

load is made to generators connected to this node.  Thus, network nodes define the 

hierarchical tree structure and act as anchor points for Installations and Buildings.  For 

example, waste heat tree nodes are tree nodes that deal specifically with the aggregation of 

waste heat and prompt to attach waste heat and cold (WH/C) recovery technologies in order 

to process the waste heat.  Processing waste heat is the act of rejecting waste heat to the 

atmosphere. Consequently, "Demand" can be considered as the amount of waste heat 

processing which occurs, whereas "Generation" is considered as the production of waste 

heat by, e.g., chillers. In the virtual model, waste heat nodes involve calculations based on 

power only; they do not involve water flow rates, supply temperature, return temperature or 

other thermophysical properties of water. 

• The physical network modelling is a more complex modelling approach, whereby hydraulic 

and thermal calculations are performed alongside water flow rates and supply and return 

temperatures which allow the heat network model to include distribution losses, and a more 

accurate picture of how to network operates. The development of a physical network model 

is more relevant to an external exploitation of a site waste heat/cold resource potential, by 

recovering and distributing such a waste heat/cold resource potential to the community (i.e. 

site surrounding buildings) through a district heating or cooling network. The physical 

network modelling approach is detailed in Section C.  

To begin developing a baseline network model, a new 2D virtual network view should be created and 

opened. To do so, click the “+” button and select 2D virtual network view. Note this 2D virtual network 

view can be visualised in various ways: geographical view (i.e. buildings are geolocated on a map), 

schematic view (i.e. hierarchical tree structure), custom view. Then select the building you wish to 

start developing a relationship between and drag them into the workspace. The selected buildings 

will appear into the 2D virtual network geographical view in the exact geolocation at which they 

belong to. The example in the image below show the 3 highlighted buildings which were selected and 

dragged into the workspace (2D virtual network schematic view). 
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Figure 46 Adding a 2D virtual network schematic view in iVN for network configuration. 

 

Now it is possible to create the relationship model. It should be noted that this model is a hierarchal 

model where links are drawn from “parent nodes” down to “child nodes”. 

Assets can be connected to nodes. The connections represent the flow of energy in the network. The 

nodes represent decision points where supply and demand meet. 

Nodes must be selected and connected as a source (i.e. provides heating, cooling, electricity etc.) or 

sink (i.e. consumes heating, cooling, electricity etc.). Firstly, right click on a node and select “select 

iVN item for connection”. Secondly right click the connection node and select “connect iVN item” and 

choose either “As Sink” or “As Source” depending on what is relevant in this network connection. In 

the below example the cooling node was selected first and the building selected second as the sink 

for cooling (as it will consume cooling energy from this cooling node for air conditioning). To note, 

multiple nodes/buildings/assets can be selected at any one time for connection if required and 

connecting to the same item, also, if you click away from these items during the process it will 

deselect them. 
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Figure 47 How to link buildings and nodes within an iCD network. 

 

For the following example we will have two buildings that have 2 separate cooling load/nodes as 

sources which then ultimately sends the waste heat from this process to one waste heat sink node, 

as well as another separate building which is heated by a heat source node. 

 

Figure 48 A multi-building and node network within a baseline structure. 

 

By double-clicking on one building we can see the demand profiles already imported and add as 

required. Associate the channels to each building as required. 
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Figure 49 The demand and generation editor for buildings where data can be edited as required. 

 

It is possible to amend the associated loads if required in this box. The Multiplier column can be used 

to turn off certain loads if non-applicable or to increase the contribution of certain loads (for example 

if a system is added but there is a multiple of these and the factor needs to be increased). As simulated 

data can be imported (from iSCAN/iCD) along with metered data it is preferable to turn off the 

simulated data as real-world metered data is available. If simulated data is present while there is also 

metered data simply set the multiplier for the simulated data to 0. The commodity types and whether 

the load is a source (generation) or demand (sink) for the building can be amended by double clicking 

the relevant box and new demands or generators can be added as required. Ensure these are correct 

and add/amend as required. 

When the network has been fully developed and the associated building and node details are inputted 

a simulation for the baseline model should be undertaken. This baseline network model will allow for 

the performance of the building(s) to be viewed and compared to a later scenario network model, 

which will include potential waste heat and cold (WH/C) recovery technologies, as well as potential 

renewable energy sources to be added, as discussed in the next section.  

Select the network to be simulated from the object browser, then open the simulation hub, tick the 

‘Network Simulation’ button and hit ‘Simulate’. Make sure the start and end dates for the simulation 

corresponds to the dates for which you have simulated your buildings, so that the timestamps of the 

imported demand profiles will match the ones of the added assets. 



 

Deliverable 4.8 SO WHAT Manual 
Page 47 of 66 

  
 
 

This project has received funding from  

the European Union’s Horizon 2020 research and innovation 

programme under grant agreement No 847097 

Security level: RINA/CL/SENSITIVE 

 

Figure 50 Running a network simulation within the simulation tab for the baseline model. 

 

During this simulation, the iVN will make calculation at each timestep (60 mins by default) on the 

energy generation, total and residual energy demand, CO2 emissions and more. Once the simulation 

is finished, we can check the results by opening the analysis inspector, clicking on a node or asset in 

the network and plotting any of the variables available in either table results, line charts or bar charts. 

Hold control and left click on various assets to select them together and be able to plot different 

variables on a single chart. Click then on one of the 3 chart types to plot results. 

 

Figure 51 Analyse network results table. 



 

Deliverable 4.8 SO WHAT Manual 
Page 48 of 66 

  
 
 

This project has received funding from  

the European Union’s Horizon 2020 research and innovation 

programme under grant agreement No 847097 

Security level: RINA/CL/SENSITIVE 

 

Figure 52 Analyse network results line chart. 

 

 

Figure 53 Analyse network results bar chart. 
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6.2.3 iVN  network model scenario 

As explained in the previous section, the virtual and physical network models can be seen as two 

different aspects of the iVN network modelling platform: 

• The virtual network modelling provides simple Hierarchical Demand Aggregation and Supply 

Allocation (HDASA) whereby waste heat network nodes represent the points in the network 

where the demand for commodities is aggregated at a node and the allocation of load is 

generators connected to this node. 

• The physical network modelling is a more complex modelling approach that considers the 

real-world infrastructure that connects the building (e.g. electric cables and water pipes) 

within the model and site., which allow the network model to include distribution losses, and 

a more accurate picture of how to network operates. 

For both modelling approaches, virtual and physical, it is possible to address different scenarios 

without affecting the existing baseline network model.  To do so, from the object browser, right click 

on the project name and select ‘Copy to new scenario’. This will make an exact copy of the model, 

including both the 2D virtual network and the 2D physical network views, which you can then rename 

as you wish. 

For the following example the scenario that is being shown below is one where the 2 buildings have 

independent cooling systems (i.e. cooling required in a manufacturing building). The waste heat is 

then transformed though a heat exchanger to supply heat for another building. At this time the 

physical network will not be modelled so physical infrastructure will not be included (details on the 

physical network modelling approach are introduced in Section C). 

As it can be seen cooling source nodes are connected to buildings, which are then source buildings 

for a waste heat node. This waste heat node is the source for the custom installation asset which 

would have to be configured and have relevant technical details associated to it as per the heat 

exchanger system that does or could theoretically exist. This heat exchanger custom installation 

asset is then the source of the heat node, which in turn is the source of heat to meet the final building 

heat demand. 

The custom installation asset, which has been classified as a heat exchanger in this example, has no 

innate properties, unlike the other standard assets that have preconfigured operations and input 

variables, which can be edited directly in the iVN Data inspector. As such this custom installation 

asset allows the user to define the function and operation through Python scripting which can be 

assigned to this custom installation asset through. To do so, a custom installation asset can be 

dragged from the iVN Asset Library into the 2d virtual network view, then connected to the waste 

heat and heat nodes of the network model scenario, and the relevant Python script is imported to the 

iVN, as illustrated in Figure 56 and Figure 57. 

One of the main activities carried out in the SO WHAT project has been to develop Python scripts, 

which can be associated to an iVN custom installation asset, for each of the waste heat/cold recovery 

and exploitation technologies introduced in previous Section B.6. Note these Python scripts are 

commercially sensitive, so the user should contact the SO WHAT project partners at 

info@sowhatproject.eu for more information needed in relation to these scripts. 

mailto:info@sowhatproject.eu
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For this example network, we have some of industrial waste heat resource potential which is then 

being recovered through a waste heat-to-heat (WHTH) system, in particular a district heating heat 

exchanger (DHHEX) is being used, as detailed in D1.9 report (modelling algorithms) and in D4.3 

(integration into the detailed version of the SO WHAT tool. This DHHEX has been pre-coded for 

modelling use, although specific inputs are required. The image below highlights the variables that 

require user input into the Python script for the DHHEX technology, which can be performed either 

before after importing the Python script into the iVN. These are specific technology inputs and must 

be found and assigned for the technology/equipment that is to be implemented in the system. This 

table below is an excerpt from a larger table which includes other waste heat/cold recovery and 

exploitation technologies and the variables that are to be input by the user, as further detailed in D1.9 

report. 

 

Figure 54 Variable input data required for DHHEX systems. 

 

Below shows an extract from the DHHEX Python script which requires user variable input as noted in 

the image above. 

 

Figure 55 Extract of Python code for DHHEX system and some of the variables requiring user input. 

 

To note, this code extract does have more variable inputs required within the script. This is one of the 

many scripts for the various technologies identified and all require different variables to be input. 

As it can be seen in Figure 50, when all the nodes are selected in the workspace 2d virtual network 

model view, they are also highlighted in the Object Browser and their details (which can be edited as 

required) are shown in the Data Inspector section. 
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Figure 56 Simple heat recovery network in schematic view in iVN. 

 

The Python script to be associated with the custom installation asset called “Waste Heat Exchanger” 

must be imported and assigned to this custom installation asset. For this example, it is the DHHEX 

scrip as noted previously.  

 

Figure 57 Importing Python script for custom nodes such DHHEX. 

 

Then within the model select the custom node and assign the relevant scrip to it. 
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Figure 58 Attaching imported script to the custom node in the iVN. 

 

Now that the parameters are set up, the network model scenario can be simulated, prior to compare 

these simulated results against these of the baseline network model that was simulated in the 

previous section. To do so, select the network and run a simulation. You should then review the 

results in the Analysis Inspector tab and be able to compare them to the baseline (real life) model 

allowing for the impact of this technology on the network/site/building to be analysed. Multiple 

theoretical/analysis simulations can be conducted where the network configuration and the variables 

assigned to the nodes and Python script (for the custom node for the waste energy technology) can 

be amended and changed to suit various scenarios and compared to the baseline model. 

To note, this is a simple example. A real-life building network model will likely be more complex than 

this and it should be expanded to be as detailed as possible to include all relevant nodes and building 

systems that produce and consume energy. 

 

6.2.4 Comparison against baseline results (inc. export of simulated results for baseline and scenario 

network models) 

As mentioned in previous section, in iVN, it is possible to compare results from two or more different 

scenarios. Let’s try to compare an example baseline network model to a scenario of this baseline 

model in which renewable sources have been added, namely solar-PV panels in this case. 

To do so, open both models into the 2D view, select the main electricity node in each network holding 

the control button, and then plot the residual electricity demand as a bar chart for the whole year. 

Remember you need to simulate both network models before being able to plot results. 
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Figure 59 Comparison between scenarios - energy use reduction 

 

In this example, we can see how the demand has decreased across the whole year thanks to the use 

of solar energy, especially during summer months when the radiation is higher. However, in this 

example, there still is quite high energy demand to be offset to reach a positive balance, and new 

scenarios could be created in order to analyse the impact of additional or other sources of renewable 

energy such as wind, tidal and more. 

 

Figure 60 Comparison between scenarios – Surplus generation insight 
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During the weekends, the residual electricity demand even reaches a negative value, which means 

there is surplus of generation compared to the site electricity demand. This could lead to either a local 

energy market, where feasible, or it could be used to eventually charge an electricity storage to then 

re-use the stored energy when most needed. A line chart could be plotted to better understand when 

the peak generation/demand happens, to address the best strategy to exploit the renewable 

generation, as seen in Figure 60 above. 

 

6.2.5 Export from iVN to iSCAN of simulated results 

The “Export results to iSCAN” feature enables users to export iVN result variables to iSCAN to form 

iSCAN data channels for use by other ICL and 3rd party tools.  

The heading ‘Export’ is a new addition to the Homepage navigator bar. The ‘Publish to iSCAN’ section 

is where users setup and manage iSCAN endpoints and iVN object results variables for export. 

 

Figure 61 iVN export 'Publish to iSCAN' section 

 

To create an iSCAN endpoint the user selects the ‘Add iSCAN endpoint’ button. This adds a new row 

to the iSCAN endpoint management table. The ‘Status’ indicator informs the user whether the iSCAN 

endpoint URL and token is valid e.g. Ok = green status, Failed = Red status.  

There is no limit on the number of iSCAN endpoints that can be added to the table. Selections and 

settings within the ‘Model > Object name’ table are persisted at the project level against the activate 

iSCAN endpoint.  

To avoid sharing sensitive iSCAN endpoint project token data, shared projects do not display the 

iSCAN endpoint project token data and instead **** are displayed. Only users that have added the 

iSCAN endpoint can manage and edit the iSCAN endpoint row. 
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Figure 62 iVN export 'Publish to iSCAN' URL and token. 

 

The ‘Model > Object name’ table lists each model/scenario(s) within the loaded project. 

Commodity level result variables per model/scenario are added to ‘Model > Object name’ table by 

right-clicking the Network heading within the Object browser and selecting the ‘Add to Publish to 

iSCAN' option. 

 

Figure 63 Object browser ‘Add to Publish to iSCAN' option for commodity level result variables. 

 

Commodity level result variables for the selected model/scenario are displayed under the relevant 

model/scenario heading in the ‘Model > Object name’ table. 

 

Figure 64 Display of commodity level result variables 

 

‘2D Virtual’ related objects, except network nodes, can be added to the ‘Model > Object name’ table 

by right-clicking the relevant object within the Object browser or via the ‘2D Virtual viewer’ and 

selecting the ‘Add to Publish to iSCAN' option. 
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Figure 65 Object browser ‘Add to Publish to iSCAN' option for ‘2D Virtual’ related objects. 

 

The selected object(s) (e.g. PV array) are displayed under the relevant model/scenario heading in the 

‘Model > Object name’ table. 

 

Figure 66 Display of ‘2D Virtual’ related objects. 

 

By selecting the ‘Manage’ button a user can manage the results variables that are to be exported on 

an object by object type basis. The ‘Object result variable’ dialog includes a number of default 

selections and can be edited by the user. 

 

Figure 67 ‘Object result variable’ dialog to manage the results variables to be exported to iSCAN. 
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Once setup is complete. The user is required to select a valid iSCAN endpoint (i.e. active) and at least 

1 model/scenario (row) within the ‘Model > Object name’ table. Selection of the ‘Publish’ button 

enacts the publish and creation of iSCAN data channels in iSCAN based on iVN result variables.  

A progress bar informs the user on the Publish to iSCAN progress. 

 

Figure 68 Progress bar to inform the user on the Publish to iSCAN progress. 

 

Upon completion, the ‘Last exported’ and ‘Update available’ columns are populated in the ‘Model > 

Object name’ table.  

The following format for exported iVN results variables in iSCAN is as follows:  

• iSCAN building = iVN project name - iVN Model name 

• iSCAN data channel = Object type name – result variable name 

Once completed, the user can either use iSCAN features to post-process the exported results and/or 

visualise these exported results directly for analysis purposes, or the user can contact directly the SO 

WHAT project partners at info@sowhatproject.eu in order to collaborate on the development and 

setup of ad-hoc online Dashboards, whereby specific widgets and pages can be created and tailored 

for an appropriate visualisation and sharing of specific KPIs. 

 

  

mailto:info@sowhatproject.eu
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Section C Waste Heat/Cooling potential for the 
community 

 

There are several elements to this Section depending on what the user wishes to achieve. Whichever 

aspects the user wants to analyse, the first two sub sections – namely (1) identifying an area of 

interest and (2) assigning data - need to be completed. From here, the user may set up and perform 

analysis on the following: 

• Heat and Cooling Demand of buildings  

• District Heating Network to supply buildings 

• Potential Renewable Energy Sources  

How to perform each of the above is explained further in the sub sections below. 

1. Identify and select area of interest 
The area of interest should be imported into iCD via OSM (Open Street Map). If an 

industrial/manufacturing analysis has been done (Section B), then this may have already been 

completed, but if not, Section  B 5.1 shows how to perform this action. This will allow for base 

information for the site and surrounding buildings to be present and for additional information to be 

added.  

Boundaries for the area may also be imported using an imported shapefile (.shp) which could be 

sourced from QGIS (https://www.qgis.org/en/site/) and imported as shown in the figure below: 

 

Figure 69 Import shapefile 

 

Final manual tweaks can then be made where building geometry has changed or is not correct in the 

model / file. 
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2. Data assignment 
Each building can be assigned various attributes within iCD, which can be edited manually, or 

imported from other files (.geojson,.shp, .csv).  For SO WHAT, the attributes can be related to: 

• Geometry Characteristics 

• Building type 

• Building General information (if known) 

Most building data can be added in in the area of the iCD software as shown below: 

 

Figure 70 Building attributes available in iCD. 

 

However, for SO WHAT, the following custom attributes can also be applied to the all buildings 

regarding their type:  

• Commerce 

• Education 

• Health care 

• Hotel 

• Office 

• Public administration 

• Residential 

• Restaurant 

• Sport 

If the user already knows the buildings energy and heat demand, it can be either imported from 

iSCAN and exported to iCD (see Section B5.2), or created from the use of PLANHEAT software which 

is specific to SO WHAT (see next Section). 
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3. Model the heat demand of buildings in the area using PLANHEAT 

It should be noted that the functions performed in the Section are to be completed by a SO WHAT 
Consultant using PLANHEAT software. If the user wishes to model the heat/cooling demand of 
buildings in their area, then please contact info@sowhatproject.eu.  

PLANHEAT is developed by RINA Consulting for the SO WHAT project and integration between the 
main SO WHAT software and PLANHEAT has been developed so that current thermal energy 
(heating, cooling and DHW) demand per each building at district scale can be modelled. 
 

Reference to the PLANHEAT instruction manual (provided by RINA Consulting, will detail how to 

operate it in conjunction with IES analytical software and models while also explaining its 

functionality in greater detail. 

4. Set up district heating network 
To perform this function, the user will need to have iVN software open.  The Object Browser displays 

objects in the 3D or 2D workspace views. The ability to draw, display and edit parameters (i.e. pipes, 

connections, supply/return temperatures, flow rates, etc) for district heating networks in the iVN has 

been added for SO WHAT.  

In order for there to be a District Heating Network, the following should be present: 

• Large, centralised, heat generator facilities heat a circulating fluid (usually water or steam) to 

a relativity high temperature. 

• Potentially smaller decentralized heat generators that operate with medium temperature; 

• Pumping facilities pressurize the circulating fluid so it can flow to the end-points (i.e. the 

consumers of heat). 

• Ducts and pipelines carry the circulating fluid directly to the end-points or to heating 

substations, that act as intermediate facilities with additional pumps or heat exchanges. 

• The circulating fluid is exchanged at the end-points using configurable heat exchangers. 

• The warm water, which has been cooled at end-points, is returned back to the heat 

generators parallel return pipes. 

For district heating to be successful, it must consider the availability and cost of fuels (or other 

exploitable heat sources), the topology of the landscape (important for the pressurized hydraulics 

system) the demand for heat at end-points and the local climate, which heavily influences demand 

and operating characteristics of the network. 

4.1 Configure assets & draw and configure a district heating network 
The 2D virtual network is configured by connecting all iVN assets to the nodes for the types of 

network which are to be simulated. The role of the network nodes is to act as decision points in a 

network where energy demand are aggregated and loads are allocated (to dispatchable assets), using 

a control strategy, in order for the providers to meet the demand. Linked nodes create a hierarchy of 

aggregation through parent-child relationships.  

mailto:info@sowhatproject.eu
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Figure 71 iVN 2D virtual and physical network views. 

 

Users can add 3D building objects to the 2D virtual network by right-clicking the 3D building object in 

the Object browser or 3D viewer and selecting the ‘Add to virtual network’ option. 

 

Figure 72 3D viewer and selecting the ‘Add to virtual network’ option. 

 

A user can also drag/drop assets from the Asset library onto the ‘Virtual viewer’ and form connections. 

 

Figure 73 Drag/drop of assets from the Asset library onto the 2D ‘Virtual viewer’ 
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Upon creation of a 2D virtual network users can also create a 2D physical network (previously known 

as 2D infrastructure (Level 2) network) for electricity and heating. The 2D physical network viewer is 

a single viewer that displays both electricity and heating/cooling physical networks.  

With exception of network nodes, users can add objects displayed in the 2D virtual network to the 2D 

physical network by right-clicking the object in the Object browser or virtual network and selecting 

the ‘Add to physical network’ option. 

 

Figure 74 2D virtual network view ‘Add to physical network’ option. 

 

To form physical connections between objects in the 2D physical network viewer, a user is to right-

click the object of interest and select a ‘Draw’ option. E.g. the CHP object in the 2D physical network 

viewer enables a user to draw an electricity and/or heating physical connections (branch, pipe) from 

the CHP to another object. 

 

Figure 75 2D physical network viewer ‘Draw’ option. 

 

The ‘Draw [network type] name’ is a polyline feature enabling users to form physical connections 

based on map topology. Heat junction(s) and bus(es) for heating and electricity physical network 

respectively, are drag/ dropped from the Asset Library onto the ‘Physical network viewer’ and 

connections formed. 
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Figure 76 2D physical network viewer ‘Draw [network type] name’ polyline feature. 

 

Upon forming and completing physical connections between objects in the 2D physical network 

viewer, simulations are performed via the Simulation hub. The action required to conduct the 

simulation were explained in Section B 6.2.2, so please refer back to this. 

Results are analysed via the Analysis Inspector, which is explained in more detail in Section B 6.2.4, 

so please refer back to this.  

5. Understand the potential supply of energy from Renewable Sources 
 

It should be noted that the functions performed in the Section are to be completed by a SO WHAT 
Consultant using PLANHEAT software. If the user wishes to understand the potential for renewable 
energy sources in their area, then please contact info@sowhatproject.eu.  

PLANHEAT is developed by RINA Consulting for the SO WHAT project and integration between the 
main SO WHAT software and PLANHEAT has been developed so that potential renewable energy 
sources for a given area can be assessed in the PLANHEAT software, and the results displayed in the 
SO WHAT tools. The renewable energy sources that can be assessed are as follows: 

• Biomass 

• Wind turbines 

• Solar PV 

• Solar thermal 

 
Reference to the PLANHEAT instruction manual (provided by RINA Consulting, will detail how to 

operate it in conjunction with IES analytical software and models while also explaining its 

functionality in greater detail. Once the potential for supply of energy from renewable sources has 

been assessed, this can also be simulated in iVN for potential integration with existing manufacturing 

site or district models.  

mailto:info@sowhatproject.eu
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Conclusion 
 

Overall, this report has provided a manual for the SO WHAT commercial/advanced tool which can 

now be used as a step-by-step guideline to enable new users to investigate ways to recover and 

exploit their waste heat and/or cold (WH/C) resource potential, either by re-using this resource 

internally (on-site) or by distributing it externally (to local district buildings/sites through a district 

heating/cooling network). 

How to install the necessary software and how to utilise the tools to develop a model appropriate for 

waste heat/cooling energy recovery and been explained as has how to prepare the models, upload 

data, run simulations, and review and analyses the results.  

A methodology on how individual sites may identify relevant waste energy recovery technologies to 

investigate and model as well as the relevant building and data that would be best suited to this 

analysis has also been included. 

Following this report, the next steps are to adjust it so that it can be formally used as a User Manual 

(mainly by removing the Executive Summary and Conclusion), and then to also create and Online 

Version which will act as D4.6 Delivery of self-learning modules. Following this, training videos will 

also be created as part of D7.6 Training Resources for Relevant Stakeholders. 
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Annex A – Data Checklist 

 

Figure 77 Sample of demo-site data checklist, part 1. 

 

 

 

 

Demonstration Sites Data Checklist Example

Participant Organisation Name Code IESRD

Participant Location Dublin (IE)

Participant Sector R&D

Respondent Title Facility Manager

Industrial site information
Available?

(Y/N)

Readily

accessible?

(Y/N)

Shareable?

(Y/N) Specify or Comment

Industrial site layout, plans, at a site level pdf, dwg, dxf files

Industrial site audit report and year of completion Audit report number and year of completion 

Industrial site list of processes process = e.g. production line and components within this 

Industrial site list of services
service = e.g. boiler, chiller, air-compressing system, etc., 

that is not directly integrated as a component within a 

Industrial site list of input and output material type(s), 

quantity unit and range(s) of temperature

e.g. cold water (m
3

), hot water (m
3

), solids (kg), liquids 

(m 3 ), recycled (kg), etc. input temperature below 100°C, 
Industrial site list of input and output product type(s), 

quantity unit and range(s) of temperature

e.g. biscuits (kg), dough (kg), etc. output temperature 

within 75-100 °C range

Industrial site layout, plans, at industrial process level pdf, dwg, dxf files

Industrial site energy storage system type (thermal, e.g. ice thermal storage, 200 MW

Industrial site energy storage system location and pdf, dwg, dxf files or other diagrams

Industrial site and/or industrial process logistics strategy e.g. just-in-time manufacturing process, production line 

Industrial site and/or industrial process final product stock 

capacity and location on-site

e.g. final product stock constraints, average final product 

units stocked on-site, minimum and maximum stock 

Are there any Industrial site energy sub-metering and/or 

production data monitoring systems installed? If so, 

e.g. Yes, overall energy consumption (gas, electricity, 

heat, etc.), i.e. for all manufactory site processes, 

Where are the data collected from Industrial site sub-

metering and/or monitoring systems stored?
e.g. online database

Waste heat/cold recovery & Renewable 

heat/cold and electricity
Available?

(Y/N)

Readily

accessible?

(Y/N)

Shareable?

(Y/N) Specify or Comment

Existing waste heat-to-power conversion technologies 

(including waste cold) in operation or installed
e.g. ORC (Organic Rankine Cycle), etc.

Existing waste heat-to-heat recovery technologies 

(including waste cold) in operation or installed

e.g. Heat recuperators/regenrators, Heat pumps, 

Sorption chillers, District heating or cooling, etc.

Existing other renewable energy systems (RESs) in 

operation or installed for heat/cold or electricity 

e.g. Solar Thermal Collector (STC), Cogeneration Heat 

and Power for heating or cooling (CHPH or CHPC), Solar 

Document on any waste heat/cold recovery technologies 

and RESs

e.g. Photovoltaics (Solar PV) panels area, inclination, 

orientation, type, manufacturer's data, electricity 

production;

Solar Thermal Collector (STC) panels area, inclination, 

orientation, manufacturer's data;

Industrial site processes information, per 

process
Available?

(Y/N)

Readily

accessible?

(Y/N)

Shareable?

(Y/N) Specify or Comment

Process name e.g. Biscuit production line X

Process component(s) name e.g. Oven X, Conveyer Y, etc.

Processed product category e.g. Biscuits

Processed product name e.g. Dry Biscuits

Processed product unit e.g. kg

Processed product maximum flow rate e.g. 1500 kg/hour

Production profile for process material inputs and outputs e.g. On continously

Process energy inputs (electricity, gas, heat, etc.), 

consumption (daily and/or weekly and/or monthly and/or 

e.g. Daily electricity consumption of X kWh, peak 

electricity demand of Y kW

Process inputs from industrial site service(s) e.g. Oven X is supplied with hot water by Boiler Y and 

Process heat/cold output type(s) (air, water, gas, etc.), 

strategy (i.e. released into space or extracted?) and 

e.g. Exhaust air from Oven X, heat output released into 

industrial site space at temperature within 200-250 °C

Process waste heat/cold type(s) (air, water, gas, etc.), e.g. Waste heat from Oven X exhaust air used for 

Are there any process energy sub-metering and/or 

production data monitoring systems installed? If so, 

e.g. Yes, Oven X energy consumption (gas, electricity, 

heat, etc.), exhaust air temperature, and production rate 

Where are the data collected from process sub-metering 

and/or monitoring systems stored?
e.g. online database
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Figure 78 Sample of demo-site data checklist, part 2. 

Demonstration Sites Data Checklist Example

Participant Organisation Name Code IESRD

Participant Location Dublin (IE)

Participant Sector R&D

Respondent Title Facility Manager

Industrial site services information, per 

service
Available?

(Y/N)

Readily

accessible?

(Y/N)

Shareable?

(Y/N) Specify or Comment

Service name e.g. Boiler X, Air-compressing system Y

Service peak operating capacity e.g. Boiler X thermal capacity = 350 kW, etc.

Service operating hours for each day/night of the week e.g. Boiler X operating hours are from Monday to Friday 

Service percentage rating (against peak operating 

capacity) during operating and non-operating hours for 

e.g. Boiler X operated at 90% of operating capacity 

during operating hours, at 25% of operating capacity 

Service intermittent periods during daily operation e.g. There are 3 intermittent periods of 30 minutes each 

Service holiday and servicing periods e.g. Boiler X is usually shut down for servicing from 1st of 

Service production calendar e.g. Boiler X production calendar is from 1st  of Jan to 

Service energy inputs (electricity, gas, heat, etc.), 

consumption (daily and/or weekly and/or monthly and/or 

e.g. Daily electricity consumption X kWh, peak electricity 

demand of Y kW

Service output to industrial site process(es) e.g. Boiler X is supplying this processes Y and Z

Service heat/cold output type(s) (air, water, gas, etc.), 

strategy (i.e. released into space or extracted?) and 

e.g. Exhaust air from Boiler X, heat output is released 

outdoor at temperature below 100 °C

Service waste heat/cold type(s) (air, water, gas, etc.), e.g. Waste heat from Boiler X exhaust air used for 

Is there any service energy sub-metering and/or 

production data monitoring system installed? If so, please 

e.g. Yes, Boiler X energy consumption (gas), exhaust air 

temperature, and output hot water tempearature 

Where are the data collected from service sub-metering 

and/or monitoring systems stored?
e.g. online database

Automated Meter Reading (AMR) data 

and energy costs information
Available?

(Y/N)

Readily

accessible?

(Y/N)

Shareable?

(Y/N) Specify or Comment

Fossil Fuel Yearly (kWh) e.g. 2250 kWh gas

Electricity Yearly (kWh) e.g. 1862 kWh electricity

Electricity bills

Total energy costs for electricity, or break down of month 

energy bills in kWh / cost

e.g.  Jan - 100kWh, €60

feb - 120kWh, €70

Fossil fuel bills

Total energy costs for fossil fuel, or break down of month 

energy bills in kWh / cost

 e.g.  Jan - 100kWh, €60

feb - 120kWh, €70

Existing energy metering infrastructure (e.g. smart 

metering) and characteristics (time and space resolutions, 

e.g. electricity smart metering, 15-min time resolution, at 

a building level, remote data access and extraction 

Existing energy supply tariffs and schemes (e.g. ToU e.g. Electricity Day/Night tariffs, or other time-of-use 

Is there any building energy management system (BEMS) e.g. lighting control

Is there any smart sensor in the building (e.g. measuring e.g. yes, temperature sensor in building room/area X
Where are the data measured from the smart sensors 

stored?
e.g. online database

General building information
Available?

(Y/N)

Readily

accessible?

(Y/N)

Shareable?

(Y/N) Specify or Comment

Building ID e.g. is there any national/local building identifier 

Building construction year e.g. 2002

Building condition (Bad, Fair, Good) e.g. Good 

Building ownership e.g. Tenancy, Owner-occupied, etc.

Building hours of use (Morning & Evening & Night) e.g. 9am - 5pm Mon-Fri

Building type e.g. Office

Building address e.g. Office, Block 1, Street Name

Building HVAC system type(s) (e.g. heating/ cooling / e.g. Radiators for heating & Natural ventillation for both 

Building HVAC fuel(s) utilised e.g. Gas for heating and DHW

Building floor area (GIFA / Net) e.g. 1987 m 2

Building floor plans pdf, dwg, dxf files

Building elevation plans pdf, dwg, dxf files

Building section plans pdf, dwg, dxf files

Building fenestration area e.g. 345 m 2

Building construction material type(s) e.g. Concrete frame construction

Building Energy Performance Certificate (EPC) level (with e.g. B3

Site photographs e.g. jpeg files


